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1 Introduction 

The eTSCA/e-PMN reporting software is a multi-function desktop application that helps industry 

comply with TSCA by providing a user-friendly interface for the submission of various TSCA-

related forms to the Environmental Protection Agency (EPA).  

 

The eTSCA/e-PMN reporting software is able to perform the following main functionalities: 

 

• Create an electronic version of the Premanufacture Notice Form (PMN) 

• Create an electronic version of the Notice of Commencement Form (NOC) 

• Create an electronic version of the Biotech form 

• Create a supporting/supplemental form to submit information for a previously submitted 

PMN 

• Validate the data in a form 

• Sanitize PMN data 

• Create PDF versions of a form suitable for printing 

• Allow attachments 

• Edit form data 

• Save incomplete form data 

• Open a previously saved form 

• Provide integrated help 

• Allow forms to be submitted on paper, on CD, or online. 

• Be standalone and platform-independent  
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2 Getting Started 

2.1 System Requirements 

Systems must meet the following set of minimum requirements to run the eTSCA/e-PMN 

software: 

 

Machine Specifications 

• 200 MB Hard Drive Space 

• 1GB RAM 

• 500Mhz Pentium PC or equivalent (2.0 Ghz recommended) 

• 800 x 600 screen resolution (1280 x 1024 recommended) 

Operating System 

• Windows XP  

• Mac OSX 

• Linux Fedora 10 

Browser 

• Internet Explorer 6 or higher 

• Firefox 3.5 or higher 

• Safari 4 or higher 

Additional Software 

• Java Version 6 or greater 

• Java Web Start version 1.6 or greater 

 

These requirements reflect those of Java Web Start version 1.6. For questions concerning Java 

requirements, please refer to the Sun Microsystems website at http://java.sun.com.  

 

For questions concerning the eTSCA/e-PMN software requirements, please contact the CDX 

Help Desk at helpdesk@epacdx.net or call 1-888-890-1995 between the hours of 8am – 6pm 

EST.  

2.2 Installation 

There are two methods for installing the eTSCA/e-PMN software.  The Web Start installation 

option can be accessed and downloaded via two CDX internet sites.  The version of the 

eTSCA/e-PMN software with encryption requires a CDX login, whereas the version of the 

software without encryption can be accessed at https://cdx.epa.gov/ssl/cdx/eTSCA-

DownloadLiteClient.asp.  The InstallAnywhere version runs off a CD and may be more suitable 

for users without an internet connection.   

2.2.1 Web Start Installation (with encryption) 

To download the eTSCA/e-PMN reporting software from the CDX website, log in normally to 

http://cdx.epa.gov. The installation files can be retrieved from the “TSCA: eTSCA Client 

Download” link located on the user’s MyCDX page [Figure 2-1]. This link will only appear if 

the user has registered and been approved  under the TSCA Program.  
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Figure 2-1 MyCDX Page / Link to eTSCA/e-PMN software download 

 

 

 

The page seen in Figure 2-2 contains a link to the install file for the eTSCA/e-PMN software. 

There are two (2) versions of the software: a full version and a lite version. The full client 

includes all of the required encryption libraries to enable online file submission, whereas the lite 

client does not include the encryption libraries and submissions must be made via CD. Note that 

only the full client is available for download from this page. To download the lite client, users 

must visit https://cdx.epa.gov/ssl/cdx/eTSCA-DownloadLiteClient.asp. 

Figure 2-2 eTSCA/e-PMN software download page 
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To download a file, simply click the “Download Client” button. If browser issues arise with 

security certificates, the download may be blocked. This can be remedied by allowing blocked 

content, as seen in Figure 2-3 below.  

Figure 2-3 Display Blocked Content option 

 

 

 

Users may be prompted to download an updated version of Java before installing the eTSCA/e-

PMN Client. When the download starts, the screen will look similar to the image seen below in 

Figure 2-4.  

Figure 2-4 eTSCA/e-PMN Java WebStart software download 
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Once downloaded, the eTSCA/e-PMN software will automatically launch [Figure 2-5] and load 

the application [Figure 2-6].  

 
Figure 2-5 eTSCA/e-PMN Client Lite launch 

 

 

 

Figure 2-6 eTSCA/e-PMN software load 

 

 

Once the software has loaded, a shortcut icon will appear on the user’s desktop.  

2.2.2 InstallAnywhere CD Installation 

To install from a CD, navigate to the correct folder corresponding to the operating system and 

double click the .exe file. Once the file is executed, follow the on-screen directions to install the 

eTSCA/e-PMN reporting software. Users with a previous version of the program should 

uninstall first before installing the updated version. A system restart will be required after 

installation is complete. 
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Double click on the install file and InstallAnywhere begins the installation process. 

 

Figure 2-7 Install Anywhere Installation 

 

 

 

Figure 2-8 Install Anywhere Wizard Introduction 
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Figure 2-9 Install Anywhere Wizard Installing 

 

 

 

Figure 2-10 Install Anywhere Wizard Install Complete 
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2.3 Uninstalling the eTSCA/e-PMN software 

Uninstalling the eTSCA/e-PMN software can be done through the operating system’s Control 

Panel Add or Remove Programs option.  

Figure 2-11 Control Panel Add or Remove Programs 

 

 

 

Windows will prompt the user to confirm removal of the eTSCA/e-PMN client, as seen in Figure 

2-12 below.  
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Figure 2-12 Confirm eTSCA/e-PMN software removal 

 

 
 

Clicking the “Cancel” button will cancel un-installation. The “OK” button will proceed with 

software removal. Once complete, the software will no longer be listed amongst the other 

applications in the Add or Remove Program control panel, and will be absent from the Programs 

folder of the user’s start menu.  

2.4 The User Interface 

The following welcome screen appears when the eTSCA/e-PMN reporting software is first 

started. 

 

Figure 2-13 eTSCA/e-PMN software welcome screen 
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The left side navigation pane allows users to maneuver between forms, while the editor window 

on the right provides a space for the user to view and complete these forms.  

2.5 Creating a new Project 

New projects can be created by clicking on the “Create New Form” button ( ) or selecting this 

option from the File menu. A new window will appear prompting the user to select a project 

type.  

Figure 2-14 New Project Selection Window 

 

 
 

 

There are four (4) project type options as seen in the figure below.  
 

Figure 2-15 Project Types Tables 

 

Project Types 

Name File Extension 

Pre-manufacture Notice 

(PMN) 

.pmn_tsca 

PMN Support 

Document 

.sup_tsca 

Notice of 

Commencement (NOC) 

.noc_tsca 

Biotech (MCANS, 

TERA, TIER I & TIER 

II) 

.bio_tsca 

 

 

After a selection is made, the user will be asked to name the project.  
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Figure 2-16 Name File Window 

 

 
 

The project is created and the main user interface is displayed.  
 

Figure 2-17 eTSCA/e-PMN software user interface 
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2.6 Navigation 

Navigating the eTSCA/e-PMN software is simple and intuitive. Most users will move through 

the forms in the navigation pane simply by using a mouse. Clicking on a section will highlight 

the title and open the corresponding form in the form editor window.  

 

Figure 2-18 Navigation Pane 

 

 
 

The left-right arrows on the upper-right corner of the toolbar [Figure 2-19] can be used as well.  
 

Figure 2-19 Navigation arrows 

 

 

2.6.1 Navigating using only the keyboard 

For users who prefer to work without a mouse, there are a number of keyboard shortcuts to 

navigate the eTSCA/e-PMN software. When the application focus is on the navigator window, 

the Up Arrow and Down Arrow will move forward and backward respectively through the 

forms in the navigation pane. Pressing Ctrl+F will manually give focus to the form editor 

window. With the application focus on this window, the Ctrl + Right Arrow and Ctrl + Left 

Arrow combinations will work to traverse the forms. Pressing the Tab button will toggle 

between fields within a form. If a table is encountered, tabbing will only move the focus amongst 

fields within that table. To exit the table and move the focus to the field following the table, press 

Ctrl+Tab.  
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3 Using the eTSCA/e-PMN Reporting Software 

3.1 Saving a project 

Projects can be saved in an incomplete state to be finished later. Note that incomplete forms 

cannot be submitted to EPA. When Save or Save As is selected from the toolbar or the file 

menu, eTSCA/e-PMN automatically runs a validation check on the currently open form. If there 

are validation errors (due to invalid data or incomplete fields), the error message seen in Figure 

3-1 will appear, stating that the file was saved with validation errors. A validation window will 

appear at the bottom of the screen detailing the errors.  

 

Figure 3-1 File saved with validation errors 

 

 
 

Double-clicking one of the listed items in the validation window will allow users to jump to the 

page of the error for easy correction.  

 

Saving a file without any validation errors produces the following dialog box, seen in Figure 3-2.  
 

Figure 3-2 File saved without validation errors 
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3.2 Closing a project 

Projects can be closed by selecting the Close command from the File menu. Selecting the Exit 

command from the File menu will close the application completely.  
 

Figure 3-3 Closing a project 

 

 

3.3 Opening an existing project 

Opening an existing project is similar to creating a new one. Simply select the Open an Existing 

Form button ( ) or choose Open an Existing Form from the File menu to pop up the dialog 

box. Selecting a file type will filter the files that will appear on the following screen for file 

selection.  

 

Figure 3-4 Opening an existing project 
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After selecting a form type, a file dialog box will appear prompting the user to select the desired 

file to be opened. Users will only see projects of the type they have selected in the previous step. 

Double-clicking or highlighting and clicking the OK button will select the file that the eTSCA/e-

PMN software will open.  

 

Figure 3-5 Selecting an existing project 

 

 
 

3.4 Getting User Help 

3.4.1 Page-level Help 

Pressing the Question Mark button ( ) on the top right side of the toolbar [Figure 3-6 below] 

will activate the dynamic help window, which provides contextual help specifically for the page 

currently open on the form.  

 

Figure 3-6 Toolbar 
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Figure 3-7 Dynamic Help Window 

 

 

 

3.4.2 Field-level Help 

Specific fields and sections may also contain the Question Mark  icon [Figure 3-8]. Pressing 

this icon will launch a pop-up window with information specific to that field or section, as seen 

in Figure 3-9 below.  
 

Figure 3-8 Field Question Mark Help Icons 
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Figure 3-9 Field Specific Help Window 
 

 
 

3.4.3 Application-level Help 

Application-level help is available by choosing the Help Contents menu item in the Help menu 

or by pressing F1. A separate help window will appear.  

 

Figure 3-10 Application Help 
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3.5 Confidential Business Information (CBI) 

Fields marked as CBI are highlighted in red for easier identification. These fields will be stripped 

out when a sanitized version is created. (See section 5.4.1 for details on sanitation).  Some fields 

allow for curvy brackets (e.g., {CBI name}) to designate CBI.  Any data between the curvy 

brackets in these large text fields will be replaced with XXX in the sanitized version. 
 

Figure 3-11 Confidential Business Information 
 

 

3.6 Contact Profiles 

Profiles make form completion more efficient by allowing users to pre-establish and save static 

information. With the simple click of a button, users can fill in contact information fields such as 

name, address, phone number, etc. or site information fields such as address and site name. 

Profiles are not Notice-specific. Once a profile is established for a current Notice, that profile is 

stored on the user’s local machine (as profiles.xml) and can be utilized later for any other 

eTSCA/e-PMN project. eTSCA/e-PMN has the ability to store multiple profiles. 

 

A profile can be added/modified by choosing Create/Edit Profile from the Tools menu or by 

clicking on the Profile button ( ) in the toolbar. The following window will appear.  

Figure 3-12 Profiles List Window 

 

 

 

The box displays a list of profiles currently stored on the machine. Clicking Edit or New will 

bring up the Create/Edit Profile dialog box, as seen in Figure 3-13 below. To edit an existing 

profile, highlight the profile name and click the Edit button.  
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Figure 3-13 Create/Edit Profile Window 

 

 

 

Existing profiles will display all fields currently populated, as well as any blank fields. New 

profiles will display all blank fields. The Profile ID field is used to identify the profile in the 

Profiles List dialog box—this field is required. All other fields are optional. To save the profile 

information, click the OK button. 

 

Note: If creating a profile for a user registered with the Central Data Exchange (CDX), it is 

imperative that the First Name, Last Name, and Company fields remain consistent with the 

information entered at the point of CDX registration. This information will be used for 

authentication. Incorrectly entered information will not pass validation upon submission via 

CDX.  

 

To use a profile within a form or dialog box, look for the “Copy from Profile” or “Profile” link 

wherever a contact or site information section is located on a form or dialog box. 

 

Figure 3-14 below exemplifies a section where a profile may be used.  
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Figure 3-14 Submitted Identification 

 

 

Clicking the “Copy from Profile” section will display the Profiles List dialog box, as seen below.  

 

Figure 3-15 Using a stored profile 

 

 
 

Double clicking the John Smith profile (or highlighting and pressing OK) will add all of John 

Smith’s profile information into the fields. 
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Figure 3-16 Profile information transferred 

 

 

 

3.7 Validation 

eTSCA/e-PMN provides data and business validations on both a field level and an application 

level. 

 

3.7.1 Field-level Validation 

Some fields contain special business rules that require inline validation. In the example seen 

below, the “TS Code” field requires a six-character alphanumeric string value. eTSCA/e-PMN 

handles these special validation cases by throwing an error at the point of field exit, preventing 

an invalid value to be entered. The error will specify the type of input expected for the given 

field.  

Figure 3-17 Field-level validation 

 

 

3.7.2 Application-level Validation 

eTSCA/e-PMN also performs application-level validation for the entire form. Validation can be 

activated manually at any time by choosing Validate from the Tools menu or clicking the 

validate icon ( ) from the toolbar. This action will start the validation checker, which opens the 

Validation window at the bottom of the screen and displays any validation errors and warnings. 
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Figure 3-18 Toolbar Validation icon 

 

 

 

Figure 3-19 Application-level validation 

 

 
 

Validation errors are critical errors that prevent the form from being submitted. Validation 

warnings point to potential problems in the form, but are not required to be corrected. 

 

Double-clicking one of the listed items in the validation window will allow users to jump to the 

page of the error for easy correction.  

 

Validation is automatically performed upon saving an existing project or finalizing a project for 

EPA submission. 

3.8 Printing 

Forms are easily printed with eTSCA/e-PMN. The software will create printer-friendly versions 

of forms in PDF format to facilitate this process. A PDF reader tool, such as Adobe Reader, will 

be needed to open the PDF files.  

 

A PDF copy can be generated by clicking on the Print command from the File menu [Figure 

3-20] or from the toolbar [Figure 3-21]. 
 



 

eTSCA CDX Registration Guide Using the eTSCA/e-PMN Reporting Software 
December 28, 2009 28 

Figure 3-20 Printing from the File menu 

 
 

Figure 3-21 Printing from the toolbar icon 

 

 
 

A PDF file will be generated with the file name “<Project Name>.pdf” and placed in the current 

working directory. 
Figure 3-22 Saving a PDF 

 

 

Examples of PDF forms are shown below in Figures 3-23 through 3-26. 
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Figure 3-23 PMN Sample Output 
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Figure 3-24 Notice of Commencement sample output 
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Figure 3-25 PMN Support Document sample output 
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Figure 3-26 Biotech sample output 
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3.9 Attachments 

Some forms will call for a file attachment for EPA submission. The following is a list of the 

allowable file types: 

 

• Chemical structure files  

o .mol 

o .skc 

o .pdf or image type 

 

• Image files 

o .gif 

o .jpg 

o .png 

o .bmp 

 

• Document files 

o .pdf 

o .ppt 

o .doc 

o .txt 

o .rtf 

o .xls 

 

• For nucleic acid, amino acid or sequence data submitted for Biotechnology MCANs and 

TERAs or enzyme related PMNs, the preferred file formats are 

o FASTA files (.fas) 

o GenBank (.gbk) 

o EMBL (.embl) 

 

Attaching a file displays the following dialog box.  



 

eTSCA CDX Registration Guide Using the eTSCA/e-PMN Reporting Software 
December 28, 2009 34 

Figure 3-27 Attachment Dialog Box 

 

 

 

The ID field is a unique key to identify the attachment in the project. This ID is automatically 

generated by the eTSCA/e-PMN reporting software to insure that there are no duplicates.  

 

The File field contains path of the file to attach. This field is required for electronic attachments. 

If the “Check here if this is a hardcopy attachment” field is checked, a paper submission will be 

expected instead.  
 

The Name/Description displays the attachment’s title or description. 

 

The # of Pages field is for the total number of pages in the attachment. 

 

The Confidential checkbox is to indicate whether or not the attachment contains Confidential 

Business Information (CBI) 

 

The Sanitized File field is the path of the sanitized file in the case where the main file contains 

CBI. 

 

The Sanitized Name/Description field displays the sanitized attachment’s title or description.  
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4 Central Data Exchange (CDX) 

The EPA Central Data Exchange (CDX) is a service that enables users to electronically submit 

data to EPA.  

 

Pre-registration with CDX is required to submit online. Please see the CDX Registration Guide 

for more information on how to register with CDX (https://cdx.epa.gov/TSCA/ eTSCA-

CDX_Registration_Guide.pdf)  

 

eTSCA/e-PMN contains a CDX component that performs the following tasks: 

 

• Connecting to the CDX Node 

• Validation of the submission information with CDX Registration 

• Generation of the cryptographic key pair 

• Encryption of the file 

• Decryption of the file 

• Transmission of the document – ability to electronically submit eTSCA projects to EPA 

via the CDX Node 

• Transaction Search – ability to search the submitted documents by CDX Transaction ID 

number 

• Document Download – ability to download ancillary documents related to submission, 

e.g., Copy of Record 
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5 Pre-Manufacture Notice Form 

5.1 Usage 

Any organization planning to manufacture or import a new chemical substance for a non-exempt 

commercial purpose is required by Section 5 of TSCA to provide the Environmental Protection 

Agency with notice before initiating the activity. This Pre-manufacture notice, or PMN, must be 

submitted at least 90 days prior to the manufacture or import of the chemical. For more 

information on the New Chemicals Program, please visit: 

http://www.epa.gov/oppt/newchems/index.htm.  

 

The PMN form should be used to submit PMNs, SNUNs, LVEs and LoRex Exemptions and 

Modifications, TMEA exemptions, and Mock PMNs.  

 

5.2 PMN Navigation 

The toggle button seen in Figure 5-1 below will switch the view of the navigator window 

between displaying forms by name and by page number. 

 

Figure 5-1 Navigator Windows with titled by page name and page number 

 

       

 

5.3 Consolidated Submissions 

Up to six cases may be included in one submission. Any submission containing more than one 

case is considered a consolidated submission.  

 

Consolidated submissions require preapproval from the EPA. Contact EPA to receive a Pre-

Notice Communication (PNC) number before attempting to submit a consolidated submission. 
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Figure 5-2 PMN Form: PNC Number 

 

 

Users submitting a consolidated submission should denote this using the checkbox located on the 

“General Instructions” page of the PMN.  
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Figure 5-3 Denoting a consolidated PMN 

 

 

 

Consolidated submissions do not need to be specified on the PMN page 1 in advance of adding 

extra chemicals. See the Adding, Deleting, or Cloning Chemical Data section for information on 

how to dynamically add or delete a chemical group. 

 

5.4 PMN-specific actions 

5.4.1 Sanitization 

Sanitization removes CBI data from the form so that the data can be shared with the general 

public. 

5.4.1.1 Creating a sanitized version of the PMN form 

Submitters should create a sanitized PDF to confirm that all CBI has been properly denoted and 

removed. A PDF file of a sanitized PMN form can be created by selecting Print Sanitized PMN 

from the File menu or by selecting the Sanitize button ( ) from the toolbar. 
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Figure 5-4 Sanitizing a PMN 

 

 

5.4.1.2 Sanitizing attachment files 

File attachments marked as CBI require a sanitized version. The sanitized version must be 

created by the submitter and attached before submission. The validation checker prevents 

finalization of the submission until all CBI attachments have corresponding sanitized files 

attached as well.  

Figure 5-5 Sanitized file required 

 

 

 

5.4.1.3 Submitting a sanitized version of the PMN form 

When a PMN project is finalized for submission, a sanitized copy of the data is automatically 

generated within the finalized file. A separate submission is not required.  

5.4.1.4 Adding, Deleting or Cloning Chemical Data 

Users can add, delete, or create an exact copy (clone) of a chemical group (PMN Pages 4-6) by 

clicking on the respective menu items from the Edit menu or using the toolbar icons. 
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Figure 5-6 Cloning a chemical group 

 

 

Chemical groups may be added at any time, but cloning or deleting a chemical group will require 

the software focus to be on the header page for that group. 
 

Figure 5-7 Navigation for chemical cloning or deletion 

 

 

 

5.4.2 Adding, Deleting or Cloning a PMN page 

The eTSCA/e-PMN reporting software allows adding multiple copies of specific PMN pages: 

 

• PMN Page 7 – Part I, Section C., Production, Import and Use Information 

• PMN Pages 8-9a – Part II, Section A., Industrial Sites Controlled by the Submitter 

• PMN Page 10-10a – Part II, Section B., Industrial Sties Controlled by Others 

• PMN Page 13 – Physical & Chemical Properties Worksheet 

 

To add, remove, or clone PMN pages, click on the respective menu items from the Edit menu or 

use the toolbar icons.   
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Figure 5-8 Adding a PMN page 

 

 

Figure 5-9 Cloning a PMN page 

 

 
 

5.5 PMN Pages 

The paper PMN form contains 13 PMN pages. eTSCA/e-PMN follows that convention by 

splitting the eTSCA/e-PMN version of the PMN form as closely as possible into those 13 pages. 

The PMN pages are as follows: 

 

• PMN Page 1 – General Instructions 

• PMN Page 2 – Certification 

• PMN Page 3 – Submitter ID 

• PMN Page 4—Class 1 or 2 Chemical Substance 

• PMN Page 5 – Polymers 

• PMN Page 6 – Chemical ID Info—continued 

• PMN Page 7 – Production, Import, and Use Information 

• PMN Pages 8-9  – Section A—Submitter Controlled Sites 

• PMN Page 10 – Other Controlled Sites 

• PMN Page 11 – Optional Pollution Prevention 

• PMN Page 12 – List of Attachments  

• PMN Page 13 – Physical and Chemical Properties Worksheet  

• Optional Cover Letter 

 

For specific help with any of these pages, click the dynamic help button on the toolbar. See the 

Page-level Help section for more information. 
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6 Notice of Commencement Form 

6.1 Usage 

A new chemical is eligible for addition to TSCA Inventory after the PMN review period has 

expired and the PMN submitter has commenced non-exempt commercial manufacture or import. 

The submitter of a PMN must provide a Notice of Commencement of Manufacture or Import 

(EPA Form 7710-56) to EPA within 30 days of the date the substance is first manufactured or 

imported for nonexempt commercial purposes. It will then be listed on the TSCA Inventory. 

Once a substance is listed on the TSCA (Toxic Substances Control Act) Inventory, it is 

considered an "existing" chemical. 

 

For more information on filing a Notice of Commencement, please visit 

http://www.epa.gov/oppt/newchems/pubs/filenoc.htm. 
 

6.2 Notice of Commencement tab 

The main form tab contains all the fields needed to complete a Notice of Commencement form. 
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Figure 6-1 Notice of Commencement main form tab 
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6.3 CBI Substantiation tab 

Users submitting NOCs with Confidential Business Information (CBI) will be required to 

substantiate a claim in this section. 

6.4 Optional Cover Letter tab 

Additional information can be added on the Optional Cover Letter tab. When printed out, this 

information will appear on the first printed page as the cover letter. 
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6.5 Printed PDF form sample 

Figure 6-2  Sample PDF NOC form 
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7 Biotechnology Form (MCAN, TERA, TIER I & TIER 2) 

7.1 Regulation 

Under a 1986 intergovernmental policy statement and TSCA Section 5, intergeneric 

microorganisms (microorganisms created to contain genetic material from organisms in more 

than one taxonomic genera) are considered new chemicals. The Biotechnology rule sets forth the 

manner in which the Agency will review and regulate the use of intergeneric microorganisms in 

commerce, or commercial research. For more information, please visit: 

http://www.epa.gov/oppt/biotech/pubs/biorule.htm.  

 

These regulations create a reporting vehicle specifically designed for microorganisms, the 

Microbial Commercial Activity Notice (MCAN). Persons intending to use intergeneric 

microorganisms for commercial purposes in the United States would submit an MCAN to EPA 

at least 90 days before such use. EPA has 90 days to review the submission in order to determine 

whether the intergeneric microorganism may present an unreasonable risk to human health or the 

environment. 

 

The rules also address intergeneric microorganisms used in R&D for commercial purposes and 

create a vehicle for reporting on testing of new microorganisms in the environment, a TSCA 

Experimental Release Application (TERA). A TERA would be submitted to EPA at least 60 

days prior to initiating such field trials. The TERA is designed, in recognition of the needs of 

researchers, to provide a high measure of flexibility and a shorter review period of 60 days. 

Research & Development for commercial purposes are those activities which are funded directly, 

in whole or in part, by a commercial entity, regardless of who is actually conducting the 

research; or which will obtain for the researcher an immediate or eventual commercial 

advantage. For more information on Microbial Products of Biotechnology, please visit: 

http://www.epa.gov/oppt/biotech/pubs/fs-001.htm. 

 



 

eTSCA CDX Registration Guide Biotechnology Form (MCAN, TERA, TIER I & TIER 2) 
December 28, 2009 47 

7.2 Screenshot 

 

Figure 7-1 Biotech Form 
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7.3 Printed PDF Form Sample 

 
Figure 7-2 PDF Biotech Form sample 
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8 PMN Support Document Form 

8.1 Usage 

The PMN Support Document provides users with an opportunity to add supporting or 

supplemental information for an original PMN or Biotechnology submission.  

 

A support document may include the following types of information:  

 

• Letter of Support 

• Withdrawal Request 

• Test Data (Health/Ecotoxicity/Fate) 

• Amendment (changes made to PMN pages 1-13, MSDS or Physical/Chemical properties) 

• Other Correspondence 
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8.2 Screenshot 

Figure 8-1 PMN Support Document Form 
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8.3 Printed PDF Form sample 

 
Figure 8-2 PMN Support Document PDF Sample Form 
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9 Submission Process 

9.1 Finalize Command 

Projects must be finalized before submission. The finalization process insures that the submitted 

data is valid and that all preliminary steps have been completed.  

 

Select Finalize from the Tools menu, or click the Finalize icon ( ) on the toolbar to begin the 

finalization process. The validation checker will then run. If a project fails validation, the user 

will not be able to continue until the necessary fixes are made.  

 

Figure 9-1 Cannot finalize due to validation errors 

 

 

 

If no critical errors are found, the software will alert the user that a new report number has been 

generated for the current submission [Figure 9-2], and the Finalize Submission dialog box will 

appear [Figure 9-3]. 

 

Figure 9-2 New report number generated 
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The user will be prompted to select a method of submission to the EPA. Three options will be 

displayed: 

 

• “I will submit my data electronically via CDX” 

• “I will submit my data via delivery service on a CD” 

• “I will submit my data on paper” 
 

Figure 9-3 Finalize Submission Dialog Box 
 

 

 

9.2 Paper Submission 

If the paper submission option is chosen, eTSCA/e-PMN will create a PDF file in your current 

working directory called “<Project Name>_finalized.pdf” and, if necessary, a suitable for 

submission sanitized PDF file called “<Project Name>_sanitized_finalized.pdf.” For example, 

a PMN project called “proj1.pmn_tsca” will produce a “proj1_finalized.pdf” submission file. 

 

 PDF files will contain a barcode on the top-left corner of each page. This is used by EPA for 

scanning purposes. 

 

If the form contains attachments, the finalized PDF will have a header page for each attachment. 

Attachments should be printed out (if not already a hardcopy) and placed behind each attachment 

header page. 

9.3 CD Submission 

If the CD submission option is chosen, eTSCA/e-PMN will create a “finalized” project file 

called “<Project Name>_finalized.<project_type_extension>” in the current working 

directory. For example, a PMN project called “proj1.pmn_tsca” will produce a 

“proj1_finalized.pmn_tsca” read-only file. The finalized file will contain the sanitized data. 
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eTSCA/e-PMN will also create a certification PDF print out containing the MD5 checksum 

value of the file. This checksum number uniquely identifies the content of the finalized file. If 

the finalized file is changed in any way, the checksum will not be reproducible. In other words, 

the checksum guarantees that data has not been tampered with after it leaves the user’s hands. 

This file will use the naming convention “<Project Name>_cert.<project_type_extension>” 

(e.g., “proj1.pmn_tsca” will produce a “proj1_cert.pdf” file). 

 

The certification file will also contain the cover letter, the certification/signature page (PMN 

page 2) and the contact information page (PMN page 3). Please certify and sign when 

appropriate and submit the original with the CD to the EPA by courier. 

 

The finalized file must be burned to a CD and submitted along with a copy of the PDF printout 

containing the checksum. PMN and NOC form printouts must also be signed and dated.  

 

9.4 Online CDX Submission 

Only CDX registered users will be able to use the CDX submission option. Please see the CDX 

Registration Guide for more information on how to register with CDX 

((https://cdx.epa.gov/TSCA/ eTSCA-CDX_Registration_Guide.pdf). Users submitting on behalf 

of another organization must have registered the names of those companies and be authorized to 

submit for those organizations. 

 

After selecting the Finalize button and after choosing to submit via CDX, eTSCA/e-PMN creates 

a “finalized” project file called “<Project Name>_finalized.<project_type_extension>” in a 

directory of your choosing. For example, a PMN project called “proj1.pmn_tsca” will produce a 

“proj1_finalized.pmn_tsca” read-only file.  

 

Users will be prompted to enter a username and password in order to login before submission 

[Figure 9-4]. 
 



 

eTSCA CDX Registration Guide Submission Process 
December 28, 2009 55 

Figure 9-4 Login to CDX from eTSCA/e-PMN software 

 

 

 

eTSCA/e-PMN software will verify the submission information with CDX registration. If the 

data agrees, eTSCA/e-PMN will display a message informing the user that a finalized version of 

the file is being created.  

Figure 9-5 Finalization in progress 
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After clicking “OK” the following screen will appear. The user will be asked to select a 

destination folder to house the finalized version of the file.  

Figure 9-6 Select destination for finalized file 

 

 

 

Once a location is selected, eTSCA/e-PMN will save the finalized file and open the CDX Node 

Client, seen in Figure 9-7 below.  
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Figure 9-7 Node Client 

 

 

Click the “Submit File to CDX” button to continue the submission process.  

9.4.1 User Certificate and Key Pair Generation 

 

A user certificate and Private/Public Key pair is used to digitally sign and encrypt the submitted 

documents, providing security protection for eTSCA/e-PMN submissions. The certificate and 

key pair will be automatically obtained by the Node Client after the first login.  

 

The Node Client stores the following data into a keystore under the user home directory: 

• user ID 

• user private key 

• user certificate 

• creation time 

 

The following file will be created: \<userHome>\ .<userId>-cromerr-keystore.jks where 

<userHome> is a local user home directory (C:\Documents and Settings\myuser) and <userId> is 

an eTSCA/e-PMN user ID registered with CDX Web. Since this file is stored on the user’s local 

drive, the user will only be able to access the submitted documents from this specific machine 

unless the key file is copied into the same location of another machine.  In any case, the user can 

copy this file to another safe location for backup, if desired. 
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Upon clicking the “Submit File to CDX” button, the user will need to complete the electronic 

signature agreement and verify his or her identify. The following screens will be displayed.  

Figure 9-8 CROMERR page 

 

 

 

Figure 9-9 20-5-1 Security Question 

 

 

When the security question is answered correctly, the system will encrypt the document with the 

public key of the back-end server and transmit the encrypted document with related metadata to 

CDX. The CDX Transaction ID will act as a unique identifier for the submission and will be 

presented to the user for reference.  
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Figure 9-10 Submission in progress 

 

 

 

Figure 9-11 Document submitted to CDX 
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To check submission status, click the “Check Transaction Status” button. The screen below will 

display the appropriate status.  The following is a list of possible statuses and what each status 

denotes:  

 

• Processing – the CDX server has received the document 

• Received – the backend server has processed the document but the CoR has not been 

generated yet 

• Completed –the backend server has processed the document and the CoR is available 

• Failed –the document failed to transmit or was not received. Please contact the CDX 

Help Desk. 

 

Figure 9-12 Transaction Details tab 

 

 
 

After the file has been successfully submitted and processed, a Copy of Record (CoR) will be 

available for download to the submitter via the “download” icon ( ) on the “ESTCA 

Transaction Details” tab of the Node Client. The CoR will be in read-only format—no changes 

can be made to this document.  

 

The user will receive two automated e-mails from the node after successful submission.  
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Figure 9-13 E-mail Submission Notification 

 

 

 

Figure 9-14 Copy of Record Available for Download 
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9.5 Transaction History 

The eTSCA/e-PMN software allows users to search for files they have previously submitted. The 

“Search Transaction History” button can be found under the “ETSCA Transaction Search” tab of 

the Node Client as seen in Figure 9-15. 

Figure 9-15 Transaction Search and Results 

 

 

 

The user can search for a specific transaction using the “Transaction ID” and “Transaction 

Status” fields, or request a complete list of transactions during a given period by using the “Start 

Date” and “End Date” fields. Search results will be presented to the user in the “Transaction 

Search Results” panel. 

There are two icons located next to each transaction listed in the search result: the “Check 

Status” button and the “Details” button. The “Check Status” button will refresh the status column 

of a given transaction with a new CDX status. This provides the user a simple and effective 

method of monitoring transactions. The “Details” button will open the transaction details dialog. 

9.5.1 Transaction Details 

The “Transaction Details” tab (pictured in Figure 9-12 above) displays the detailed transaction 

information, including all of the documents and reports associated with the transaction. 

Transaction status can be viewed by clicking the “Check Status” button. The “Audit Details” 

button will display audit information related to the transaction, as seen in Figure 9-16. 

 



 

eTSCA CDX Registration Guide Submission Process 
December 28, 2009 63 

Figure 9-16 Audit Details Dialog 
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The “Done” button located at the bottom of the window will close the audit details.  

The user may also download available reports by clicking the “Download” icon located to the 

left of the desired report. This will automatically initiate the download process. The document 

will get decrypted with the current user private key and the “Save File” dialog will be presented 

to a user [Figure 9-17]. Reports can be saved on a local hard drive and accessed with the 

appropriate application. 

 

Figure 9-17 Save Downloaded File 
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10 Administrator’s Guide 

Windows XP 

 

To setup *.jnlp association for Java Web Start in Windows, please follow the following steps:  

 

1. In Windows, Click Start | Settings| Control Panel| Folder Options | File Types. 

2. Check to see if there is already an association for *.jnlp files. 

3. If there is no entry for *.jnlp files already then click new | advanced | select “jnlp file” 

4. If there is an entry, Select it and click advanced 

5. Then edit the open application used to perform action field and make sure it is set to 

“C:\Program Files\java\jre6\bin\javaws.exe” 

 

Mac OSX 10.5 (Leopard) 

 

JNLP files may lose association with Java Web Start after a Java software update. This will 

disable Mac OS users from downloading the eTSCA/e-PMN software using the Safari browser. 

There are two ways to re-associate JNL with the Java Web Start application. Option 1 is 

recommended for novice users, while option two may be more suitable for Mac OS experts.  

Option 1 

1. Navigate to the Core Services folder located at /System/Library/Core Services 

2. Open this folder. Opening the Core Services folder re-associates the .jnlp files with 

the Java Web Start application 

3. Close the window and reattempt to load the eTSCA/e-PMN software 

Option 2 

1. Navigate to the Terminal (/Applications/Utilities/Terminal) 

2. Enter the following command: 

 

/System/Library/Frameworks/CoreServices.framework/Frameworks/LaunchServices.

framework/Support/lsregister "/System/Library/CoreServices/Java Web Start.app" 

 

3. Close Terminal and reattempt to load the eTSCA/e-PMN software 
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11 Contact Information 

For further questions or concerns about the eTSCA/e-PMN software not covered in this user 

guide, please contact the CDX Help Desk at helpdesk@epacdx.net or call 1-888-890-1995 

between the hours of 8am – 6pm EST.  

 


